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AvePoint CallAssist for Microsoft Dynamics CRM

Overview
CallAssist is an application used to retrieve entities’ information and their columns from Dynamics CRM
2013 or Dynamics CRM 2011 by searching the Dynamics CRM database according to a user-entered
keyword. Then, the user can use the searched information to make a call, create a phone call activity,
send an e-mail, and open the entity in Dynamics CRM.
The entities and their columns from which information is retrieved depend upon what is configured in
the CallAssist Admin Tool, which limits the scope of the entities and the columns that CallAssist is able to
retrieve and use.
Refer to CallAssist for Microsoft Dynamics® CRM Installation and Configuration Guide for details on
installing CallAssist and configuring the entities and their columns in the CallAssist Admin Tool.
*Note: CallAssist is supported on the following English Dynamics CRM environments: Dynamics CRM
2011 Online, Dynamics CRM 2011 RTM, Dynamics CRM 2011 UR14, and Dynamics CRM 2013 Online and
On-Premises.
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Signing in
Double-click the CallAssist shortcut on the desktop. If your credentials are configured already, the
username and the password appear automatically on the login interface. Otherwise, enter your
credentials.

Figure 1: Login interface
On the login interface, you can perform the following actions:
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•

Select the Remember me checkbox to allow CallAssist to remember the username and the
password.

•

Select the Sign In Automatically checkbox to sign in automatically when you start CallAssist.

•

Click Settings to configure CallAssist settings. For detailed information on configuring CallAssist
Settings, please refer to AvePoint CallAssist for Microsoft Dynamics CRM Installation and
Configuration Guide.

•

Click Sign In to examine your credentials and to log into the application.
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Using CallAssist
Refer to the sections below for information on operating the CallAssist application.

Understanding the Menu Bar
In the menu bar, there are five drop-down options: File, Conversation, Call, Tools, and Help. They are
introduced as follows.

File Menu
The File menu contains the following options:
•

Settings – Click Settings to configure the CallAssist settings. For more information on configuring
CallAssist Settings, refer to AvePoint CallAssist for Microsoft Dynamics CRM Installation and
Configuration Guide.

•

Sign Out – Click Sign Out to sign out.

•

Exit – Click Exit to exit the application.

Conversation Menu
The Conversation menu contains the following options. Select a record and then perform the following
actions:
•

Log this Call – Click Log this Call to create a phone call activity.

•

Open in CRM – Click Open in CRM to open the entity in Dynamics CRM.

•

Send an E-mail – Click Send an E-mail to send an e-mail when the e-mail address is set as the
primary e-mail address.

•

Delete – Click Delete to delete the selected record.

Call Menu
The Call menu contains the following options:
•

Call – Select a record or the retrieved information and then click Call to dial the number.

•

Accept – When there is an incoming call, click Accept to accept it.

•

Hang Up –Click Hang Up to hang up the call.

Tools Menu
The Tools menu contains the following options:
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•

Check for Update – Click Check for Update to check for a CallAssist application update.

•

History – Click History; the Call History pop-up window appears. You can perform the following
actions.
o

Check the record’s detailed information. The record’s State, Contact, Phone, Time, and
Duration are listed.

o

Use the State filter, the Time filter, or enter the key word in the Phone Number or
Name field to search the desired records. The records which meet all configured filter
criteria will be displayed in the blank area.

o

Select the records and click Export to export them to an Excel document (for archiving
purposes, for example).

o

Select the records and click Delete to delete them from the history records.

Help Menu
The Help menu contains the following options:
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•

About CallAssist – Click About CallAssist to view the publisher, version, and copyright
information.

•

Product Registration – Click Product Registration to apply a license.
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Understanding the Personal Information Area
The personal information area (as shown below) displays the user’s name, avatar, and extension. Click
the avatar area on the left to select a picture to use as the avatar. Click on the right to configure
CallAssist settings. Under the name, the provider information is displayed.
•

If using ShoreTel as the TAPI provider, your telephone number is displayed under the full name.

Figure 2: The telephone number is displayed when using ShoreTel as the TAPI provider.
•

If using Skype as the provider, your Skype name is displayed.

•

If using Lync as the provider, your Lync name is displayed.
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Retrieving Record Information
The retrieve function searches for information in Dynamics CRM according to a keyword entered in
CallAssist. Follow the steps below to use the retrieve function:
1. Enter a keyword in the blank field (marked in the screenshot below). Both the entity name and
the contents contained in the specific columns that are configured in the Entity Retrieve area in
Advanced tab can be used as keywords. Also, the wildcard “*” is supported. You can enter an
asterisk (*) to stand for the character string of any length. You can also omit the following
characters in the keyword when searching for the phone numbers: - + # * ( ). For example, you
can find the phone number (123)123-4567 with the keyword “1231234567”.

Figure 3: Entering the keyword in the blank field.
2. Click the search button (
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) to start retrieving. The results will be displayed in the Contacts tab.

AvePoint CallAssist for Microsoft Dynamics CRM

Dialing a Contact
To use the dialing function, follow the steps below:
1. Enter the phone number/Sky ID/ e-mail address according to your provider in the blank field
(marked in the screenshot below).

Figure 4: Entering the Skype ID when using Skype as the provider.
2. Click the dial key ( ) to make the phone call. If desired, click the triangle button ( ) next to the
dial key ( ) to select a provider other than the default. Then CallAssist starts dialing using the
default or selected provider. Note that when the Contacts tab is selected, the blank field is a
search field, so outgoing calls cannot be made.
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Besides, you can also use the dialing functions on the All, From, To, Missed, and Contacts tab as follows:
•

Double-click the record or the retrieved information to start a call. This function is available
when the Start a call on Double-Click checkbox in the General tab is selected. After doubleclicking the record or retrieved information, the Dialing Now pop-up appears. This window
displays the entity name, phone number, the button for hanging up, call duration, the
button for creating a phone call activity, the
button for displaying/hiding the keypad, and
the keypad. Note the keypad can be displayed when using ShoreTel as the TAPI provider.

Figure 5: The Dialing Now pop-up window appears after double-clicking a record.
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•

Hover over the record/retrieved information to display additional options. Click
to dial the
number using the default provider; you can also click the triangle next to the dial key to select
another provider.

Figure 6: Hovering over the record to display addition options.

Creating a Phone Call Activity
The Create Phone Call Activity function allows you to create a new phone call activity while making a call
or by clicking
on a specific pop-up window on the All/From/To/Missed/Contacts tab.

Creating a Phone Call Activity While Making a Call
When you make a call, CallAssist can create and log a phone call activity in Dynamics CRM according to
what is configured in Create a Phone Call Activity for each call section in CallAssist Admin Tool.
•

If you select the Always option, a pop-up window for creating a phone call activity appears
when every call begins.

•

If you select Alert, when you make a call, a pop-up window appears, asking you whether to
create a phone call activity. If you choose Yes , the Phone Call Activity page appears and you
can create a new phone call activity using this page.
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To create a phone call activity using the Phone Call Activity page, refer to Creating a Phone Call Activity
Using the Phone Call Activity Page in this guide.

Creating a Phone Call Activity on a Tab
To create a phone call activity on a tab, follow the instructions as follows:
1. On the All, From, To, Missed, or Contacts tab, hover over the record/retrieved information to
display additional options.
•

On the All, From, To, and Missed tab, a pop-up window appears. Click
to create a new phone call activity for this record.

on the pop-up

Figure 7: The pop-up window with addition options.
•

On the Contacts tab, click

to create a new phone call activity.

Figure 8: Addition options.
3. On the Phone Call Activity window, refer to the Creating a Phone Call Activity Using the Phone
Call Activity Page section to create a phone call activity in your Dynamics CRM.

Creating a Phone Call Activity Using the Phone Call Activity Page
In the Phone Call Activity page, CallAssist automatically fills in the following information; this
information cannot be edited: Account, Sender, Recipient, and Phone Number.
*Note: The Recipient and Sender fields of a phone call activity in Dynamics CRM are supported for the
following four types of entities: Account, Lead, Contact, and User. When you create a phone call activity
for a specified record of these four entity types, the Recipient and Sender fields display the record
12
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names. When you create a phone call activity for a specified record of any other entity type, the
Recipient and Sender fields are blank.
To create a phone call activity, configure the following settings:
•

Direction – Specify the direction of the phone call activity you are about to create.
*Note: When you change the direction of the phone call activity, the Recipient and
Sender will be switched with each other automatically.

•

Subject – Enter the subject for the phone call activity you are about to create.

•

Description – Enter the description for the phone call activity you are about to create.
This option is optional.

•

Regarding – Use
to select and link a record to the Phone Call Activity you are about
to create. By default, the Recipient is automatically filled in this field.

•

Set As Complete – Select this option to mark this activity as Completed in Dynamics
CRM, when you get a result from this phone call. Then, this activity will be moved to the
Closed Activities view in Dynamics CRM. If you do not get a result from this phone call,
do not select this option. Then, this activity will be marked as Open in Dynamics CRM.

•

Create a New Task – If you want to create a separate task from the phone call activity
you are about to create, select this option and click OK. You will be brought to the Task:
New page in Dynamics CRM to create a new task. The new task will help you track the
things you need to get done.

Click OK to save the configuration and create this phone call activity in your Dynamics CRM.

Understanding the CallAssist Tabs
The five CallAssist tabs are described below.
•

All – Displays all records, including incoming and outgoing calls.

•

From – Displays received incoming calls.

•

To – Displays outgoing calls.

•

Miss – Displays missed incoming calls.

•

Contacts – Displays search results after retrieving information from Dynamics CRM.

The following actions can be performed regardless of the selected tab:
•

Hover over the record/retrieved information to display additional options. A pop-up window
appears.
o

On the pop-up window, the entity name, telephone number, date, and call duration are
displayed. Note that this function is not available on the Contacts tab. On this pop-up,
click
to create a phone call activity; click
to open the entity on the Dynamics
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CRM; click
to send an e-mail (when the e-mail address information exists); or click
the dial key to dial the number by the default provider. Click the triangle next to the dial
key to select another provider.

Figure 9: Buttons in the pop-up window.
•
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Right-click the record/retrieved information to display the following options:
o

Call – Click Call to dial the number.

o

Log this Call – Click Log this Call to create a phone call activity.

o

Open in CRM – Click Open in CRM to open the entity in Dynamics CRM.

o

Send an E-mail – Click Send an E-mail to open your system’s default e-mail service. A
blank e-mail with the contact’s e-mail address in the To field appears (when the
contact’s e-mail address has been set as primary e-mail by the CallAssist Admin Tool). If
the e-mail address has not been set as the primary e-mail address, you cannot send an
e-mail by clicking Send an E-mail.

o

Delete – Click Delete to delete the selected record.
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Handling Incoming Calls
When a call is incoming, a pop-up window appears displaying the information configured in Inquiry
Rules in Advanced tab. Click Accept to accept the incoming call or click Hang Up to decline it. The phone
call activity will be created according to the configured Control Settings in General tab.

Figure 10: Incoming Call pop-up window.
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Transferring Record Information from Dynamics CRM to CallAssist
Call Numbers is used to transfer record information from Dynamics CRM to CallAssist. Only the entities
and columns you configured in CallAssist Admin Tool can be transferred to CallAssist. Follow the steps
below to use Call Numbers.
1. Log on to your Dynamics CRM environment and go to the list of the entity which you have set in
the CallAssist Admin Tool.

Figure 11: Going to the list of the entity which you have set in the CallAssist Admin Tool.
2. Select the records from the list and then click Call Numbers.

Figure 12: Selecting the specific entity from the list.
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3. The information of the selected records will be transferred to the Contacts tab of CallAssist as
shown below.

Figure 13: The information is transferred to CallAssist.
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Notices and Copyright Information
Notice
The materials contained in this publication are owned or provided by AvePoint, Inc. and are the property
of AvePoint or its licensors, and are protected by copyright, trademark and other intellectual property
laws. No trademark or copyright notice in this publication may be removed or altered in any way.
Copyright
Copyright © 2013 AvePoint, Inc. All rights reserved. All materials contained in this publication are
protected by United States copyright law and no part of this publication may be reproduced, modified,
displayed, stored in a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording or otherwise, without the prior written consent of AvePoint, 3
Second Street, Jersey City, NJ 07311, USA or, in the case of materials in this publication owned by third
parties, without such third party’s consent.
Trademarks
®

®

AvePoint , DocAve , the AvePoint logo, and the AvePoint Pyramid logo are registered trademarks of
AvePoint, Inc. with the United States Patent and Trademark Office. These registered trademarks, along
with all other trademarks of AvePoint used in this publication are the exclusive property of AvePoint and
may not be used without prior written consent.
Microsoft, MS-DOS, Internet Explorer, Microsoft Dynamics, Microsoft Office SharePoint Servers
2007/2010, SharePoint Portal Server 2003, Windows SharePoint Services, Windows SQL server, and
Windows are either registered trademarks or trademarks of Microsoft Corporation.
Adobe Acrobat and Acrobat Reader are trademarks of Adobe Systems, Inc.
All other trademarks contained in this publication are the property of their respective owners and may
not be used such party’s consent.
Changes
The material in this publication is for information purposes only and is subject to change without notice.
While reasonable efforts have been made in the preparation of this publication to ensure its accuracy,
AvePoint makes no representation or warranty, expressed or implied, as to its completeness, accuracy,
or suitability, and assumes no liability resulting from errors or omissions in this publication or from the
use of the information contained herein. AvePoint reserves the right to make changes in the Graphical
User Interface of the AvePoint software without reservation and without notification to its users.
AvePoint, Inc.
3 Second Street
Jersey City, NJ 07311
USA
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